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,the	free	encyclopedia	that	anyone	can	edit.117,185	active	editors	7,002,000	articles	in	EnglishThe	English-language	Wikipedia	thanks	its	contributors	for	creating	more	than	seven	million	articles!	Learn	how	you	can	take	part	in	the	encyclopedia's	continued	improvement.Members	of	the	victorious	Blondie	crewThe	Boat	Race	2018	took	place	on
24March.	Held	annually,	The	Boat	Race	is	a	side-by-side	rowing	race	between	crews	from	the	universities	of	Oxford	and	Cambridge	along	a	4.2-mile	(6.8km)	tidal	stretch	of	the	River	Thames	in	south-west	London,	England.	For	the	third	time	in	the	history	of	the	event,	the	men's,	the	women's	and	both	reserves'	races	were	all	held	on	the	Tideway	on
the	same	day.	The	women's	race	saw	Cambridge	lead	from	the	start,	eventually	winning	by	a	considerable	margin	to	take	the	overall	record	to	4330	in	their	favour.	In	the	women's	reserve	race,	Cambridge's	Blondie	(crew	pictured)	defeated	Oxford's	Osiris	by	nine	lengths.	The	men's	reserve	race	was	won	by	Cambridge's	Goldie,	who	defeated	Oxford's
Isis	by	a	margin	of	four	lengths.	The	men's	race	was	the	final	event	of	the	day	and	completed	a	whitewash	as	Cambridge	won,	taking	the	overall	record	to	8380	in	their	favour.	The	races	were	watched	by	around	250,000	spectators	live,	and	broadcast	around	the	world.	(Fullarticle...)Recently	featured:	Radar,	Gun	Laying,	Mk.I	and	Mk.IIAndrea
NavageroNosy	KombaArchiveBy	emailMore	featured	articlesAboutKitty	Marion...	that	Kitty	Marion	(pictured)	was	force-fed	over	200	times	during	a	hunger	strike?...	that	the	North	Korean	destroyer	Choe	Hyon	is	the	largest	ship	constructed	for	the	Korean	People's	Navy?...	that	after	the	release	of	High	and	Low,	director	Akira	Kurosawa	received
telephone	calls	imitating	his	film	that	threatened	to	kidnap	his	daughter?...	that	May	Bradford	Shockley	is	why	Silicon	Valley	is	where	it	is?...	that	the	conservation	of	a	goat	might	endanger	the	survival	of	Aquilegia	paui?...	that	Joy	Laking	predicted	in	a	school	writing	assignment	that	within	ten	years	she	would	be	making	a	living	as	an	artist?...	that
the	Taiwanese	restaurant	chain	Formosa	Chang	drew	inspiration	from	McDonald's	for	its	non-greasy	atmosphere	and	corporate	practices?...	that	Haridas	Mitra	had	his	death	sentence	commuted	after	the	intervention	of	Mahatma	Gandhi?...	that	"Steve's	Lava	Chicken"	recently	became	the	shortest	song	to	enter	the	UK	Top	40?ArchiveStart	a	new
articleNominate	an	articleNgg	wa	Thiong'oKenyan	writer	and	activist	Ngg	wa	Thiong'o	(pictured)	dies	at	the	age	of	87.In	sumo,	nosato	Daiki	is	promoted	to	yokozuna.In	association	football,	Liverpool	win	the	Premier	League	title.In	motor	racing,	lex	Palou	wins	the	Indianapolis	500.In	basketball,	the	EuroLeague	concludes	with	Fenerbahe	winning	the
Final	Four	Playoff.Ongoing:	Gaza	warM23	campaignRussian	invasion	of	UkrainetimelineSudanese	civil	wartimelineRecent	deaths:	Harrison	Ruffin	TylerPhil	RobertsonMary	K.	GaillardPeter	DavidAlan	YentobGerry	ConnollyNominate	an	articleMay	31:	Dragon	Boat	Festival	in	China	and	Taiwan	(2025);	World	No	Tobacco	DayBessarion455	Petronius
Maximus,	the	ruler	of	the	Western	Roman	Empire,	was	stoned	to	death	by	a	mob	as	he	fled	Rome	ahead	of	the	arrival	of	a	Vandal	force	that	sacked	the	city.1223	Mongol	invasion	of	Kievan	Rus':	Mongol	forces	defeated	a	Kievan	Rus'	army	at	the	Battle	of	the	Kalka	River	in	present-day	Ukraine.1468	Cardinal	Bessarion	(pictured)	announced	his
donation	of	746	Greek	and	Latin	codices	to	the	Republic	of	Venice,	forming	the	Biblioteca	Marciana.1935	A	magnitude-7.7	earthquake	struck	Balochistan	in	British	India,	now	part	of	Pakistan,	killing	between	30,000	and	60,000	people.2013	An	extremely	large,	powerful,	and	erratic	tornado	struck	Central	Oklahoma,	killing	eight	people	and	injuring
more	than	150	others.Albertino	Mussato	(d.1329)Joseph	Grimaldi	(d.1837)Dina	Boluarte	(b.1962)Mbaye	Diagne	(d.1994)More	anniversaries:	May	30May	31June	1ArchiveBy	emailList	of	days	of	the	yearAboutCucumis	metuliferus,	the	African	horned	cucumber,	is	an	annual	vine	in	the	cucumber	and	melon	family,	Cucurbitaceae.	Its	fruit	has	horn-like
spines,	hence	the	name	"horned	melon".	The	ripe	fruit	has	orange	skin	and	lime-green,	jelly-like	flesh.	It	is	native	to	Southern	Africa,	where	it	is	a	traditional	food.	Along	with	the	gemsbok	cucumber	and	the	citron	melon,	it	is	one	of	the	few	sources	of	water	during	the	dry	season	in	the	Kalahari	Desert.	This	photograph,	which	was	focus-stacked	from
25	separate	images,	shows	two	C.metuliferus	fruits,	one	whole	and	the	other	in	cross-section.Photograph	credit:	Ivar	LeidusRecently	featured:	Ignace	TonenAustralian	white	ibisHell	Gate	BridgeArchiveMore	featured	picturesCommunity	portal	The	central	hub	for	editors,	with	resources,	links,	tasks,	and	announcements.Village	pump	Forum	for
discussions	about	Wikipedia	itself,	including	policies	and	technical	issues.Site	news	Sources	of	news	about	Wikipedia	and	the	broader	Wikimedia	movement.Teahouse	Ask	basic	questions	about	using	or	editing	Wikipedia.Help	desk	Ask	questions	about	using	or	editing	Wikipedia.Reference	desk	Ask	research	questions	about	encyclopedic
topics.Content	portals	A	unique	way	to	navigate	the	encyclopedia.Wikipedia	is	written	by	volunteer	editors	and	hosted	by	the	Wikimedia	Foundation,	a	non-profit	organization	that	also	hosts	a	range	of	other	volunteer	projects:	CommonsFree	media	repository	MediaWikiWiki	software	development	Meta-WikiWikimedia	project	coordination
WikibooksFree	textbooks	and	manuals	WikidataFree	knowledge	base	WikinewsFree-content	news	WikiquoteCollection	of	quotations	WikisourceFree-content	library	WikispeciesDirectory	of	species	WikiversityFree	learning	tools	WikivoyageFree	travel	guide	WiktionaryDictionary	and	thesaurusThis	Wikipedia	is	written	in	English.	Many	other
Wikipedias	are	available;	some	of	the	largest	are	listed	below.	1,000,000+	articles	DeutschEspaolFranaisItalianoNederlandsPolskiPortugusSvenskaTing	Vit	250,000+	articles	Bahasa	IndonesiaBahasa	MelayuBn-lm-gCataletinaDanskEestiEsperantoEuskaraMagyarNorsk	bokmlRomnSimple	EnglishSloveninaSrpskiSrpskohrvatskiSuomiTrkeOzbekcha
50,000+	articles	AsturianuAzrbaycancaBosanskiFryskGaeilgeGalegoHrvatskiKurdLatvieuLietuviNorsk	nynorskShqipSlovenina	Retrieved	from	"	2This	article	is	about	the	year	455.	For	other	uses,	see	455	(disambiguation).This	article	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources.
Unsourced	material	may	be	challenged	and	removed.Find	sources:"455"news	newspapers	books	scholar	JSTOR	(April	2019)	(Learn	how	and	when	to	remove	this	message)Calendar	yearYearsMillennium1stmillenniumCenturies4thcentury5thcentury	6thcenturyDecades430s440s450s	460s470sYears452453454455	456457458vte455	by
topicLeadersPolitical	entitiesState	leadersReligious	leadersCategoriesBirthsDeathsDisestablishmentsvte455	in	various	calendarsGregorian	calendar455CDLVAb	urbe	condita1208Assyrian	calendar5205Balinese	saka	calendar376377Bengali	calendar139	138Berber	calendar1405Buddhist	calendar999Burmese	calendar183Byzantine
calendar59635964Chinese	calendar	(WoodHorse)3152	or	2945to	(WoodGoat)3153	or	2946Coptic	calendar171172Discordian	calendar1621Ethiopian	calendar447448Hebrew	calendar42154216Hindu	calendars-	Vikram	Samvat511512-	Shaka	Samvat376377-	Kali	Yuga35553556Holocene	calendar10455Iranian	calendar167	BP	166	BPIslamic
calendar172	BH	171	BHJavanese	calendar340341Julian	calendar455CDLVKorean	calendar2788Minguo	calendar1457	before	ROC1457Nanakshahi	calendar1013Seleucid	era766/767	AGThai	solar	calendar997998Tibetan	calendar(male	Wood-Horse)581	or	200	or	572to(female	Wood-Goat)582	or	201	or	571King	Genseric	sacks	Rome	(455)Year	455
(CDLV)	was	a	common	year	starting	on	Saturday	of	the	Julian	calendar.	At	the	time,	it	was	known	as	the	Year	of	the	Consulship	of	Valentinianus	and	Anthemius	(or,	less	frequently,	year	1208	Ab	urbe	condita).	The	denomination	455	for	this	year	has	been	used	since	the	early	medieval	period,	when	the	Anno	Domini	calendar	era	became	the	prevalent
method	in	Europe	for	naming	years.March	16	Emperor	Valentinian	III,	age	35,	is	assassinated	by	two	Hunnic	retainers	of	the	late	Flavius	Aetius,	while	training	with	the	bow	on	the	Campus	Martius	(Rome),	ending	the	Theodosian	dynasty.	His	primicerius	sacri	cubiculi,	Heraclius,	is	also	murdered.March	17	Petronius	Maximus,	former	domesticus
("elite	bodyguard")	of	Aetius,	becomes	(with	support	of	the	Roman	Senate)	emperor	of	the	Western	Roman	Empire.	He	secures	the	throne	by	bribing	officials	of	the	imperial	palace.	Maximus	consolidates	his	power	by	a	forced	marriage	with	Licinia	Eudoxia,	widow	of	Valentinian	III.Maximus	appoints	Avitus,	most	trusted	general,	to	the	rank	of
magister	militum	and	sends	him	on	an	embassy	to	Toulouse,	to	gain	the	support	of	the	Visigoths.	He	elevates	his	son	Palladius	to	Caesar	and	has	him	marry	Eudocia,	eldest	daughter	of	Valentinian	III.May	31	Maximus	is	stoned	to	death	by	an	angry	mob	while	fleeing	Rome.	A	widespread	panic	occurs	when	many	citizens	hear	the	news	that	the	Vandals
are	plundering	the	Italian	mainland.June	2	Sack	of	Rome:	King	Genseric	leads	the	Vandals	into	Rome,	after	he	has	promised	Pope	Leo	I	not	to	burn	and	plunder	the	city.	Genseric	sacks	the	city	for	a	period	of	two	weeks.	Eudoxia	and	her	daughters,	Eudocia	and	Placidia,	are	taken	hostage.	The	loot	is	sent	to	the	harbour	of	Ostia	and	loaded	into	ships,
from	whence	the	Vandals	depart	and	return	to	Carthage.July	9	Avitus	is	proclaimed	Roman	emperor	at	Toulouse,	and	later	recognised	by	the	Gallic	chiefs	in	Viernum	(near	Arles).September	21	Avitus	enters	Rome	with	a	Gallic	army.	He	restores	the	imperial	authority	in	Noricum	(modern	Austria)	and	leaves	a	Gothic	force	under	Remistus,	Visigoth
general	(magister	militum),	at	Ravenna.The	Ostrogoths	conquer	Pannonia	and	Dalmatia.Battle	of	Aylesford:	Prince	Vortimer	rebels	against	the	pro-Anglo-Saxon	policies	of	his	father,	Vortigern.	He	is	defeated	in	the	battle	at	Aylesford	(Kent).	Hengist	and	his	son	Oisc	become	king	of	Kent.	Horsa	and	Catigern,	brother	of	Vortimer,	are	killed.	The	Britons
withdraw	to	London	(according	to	the	Anglo-Saxon	Chronicle).Skandagupta	succeeds	Kumaragupta	I	as	ruler	of	the	Gupta	Empire	(India).	During	his	reign	he	crushes	the	Hun	invasion;	however,	the	expense	of	the	wars	drains	the	empire's	resources	and	contributes	to	its	decline.Gaero	becomes	king	of	the	Korean	kingdom	of	Baekje.[1]Earliest
recorded	date	at	Chichen	Itza	on	the	Yucatn	Peninsula	(Mexico)	(approximate	date).Barter	economy	replaces	organized	trade	as	Romans	and	other	citizens	desert	their	towns	for	the	countryside,	where	they	will	be	less	vulnerable	to	barbarian	raids	(approximate	date).The	city	of	Vindobona	(Vienna)	is	struck	by	an	epidemic	that	spreads	through	the
Roman	provinces.	The	disease	is	probably	streptococcus	or	a	form	of	scarlet	fever	with	streptococcus	pneumoniae	(approximate	date).Rusticus,	archbishop	of	Lyon	(approximate	date)Wang	Baoming,	empress	of	the	Southern	Qi	(d.	512)March	16Valentinian	III,	emperor	of	the	Western	Roman	Empire	(b.	419)Heraclius,	Roman	courtier	(primicerius
sacri	cubiculi	)May	31	Petronius	Maximus,	emperor	of	the	Western	Roman	EmpireBiyu	of	Baekje,	king	of	Baekje[1]Catigern,	prince	and	son	of	Vortigern	(approximate	date)Horsa,	leader	of	the	Anglo-Saxons	(approximate	date)Kumaragupta	I,	ruler	of	the	Gupta	Empire	(India)Niall	Noigiallach,	High	King	of	Ireland	(approximate	date)Palladius,	son	of
Petronius	Maximus	(approximate	date)Prosper	of	Aquitaine,	disciple	and	Christian	writer	(approximate	date)^	a	b	"List	of	Rulers	of	Korea".	www.metmuseum.org.	Retrieved	April	20,	2019.Retrieved	from	"	3One	hundred	years,	from	301	to
400Millennia1stmillenniumCenturies3rdcentury4thcentury5thcenturyTimelines3rdcentury4thcentury5thcenturyState	leaders3rdcentury4thcentury5thcenturyDecades300s310s320s330s340s350s360s370s380s390sCategories:Births	Deaths	Establishments	DisestablishmentsvteEastern	Hemisphere	at	the	beginning	of	the	4th	century	CE.Eastern
Hemisphere	at	the	end	of	the	4th	century	CE.The	4th	century	was	the	time	period	from	301	CE	(represented	by	the	Roman	numerals	CCCI)	to	400	CE	(CD)	in	accordance	with	the	Julian	calendar.	In	the	West,	the	early	part	of	the	century	was	shaped	by	Constantine	the	Great,	who	became	the	first	Roman	emperor	to	adopt	Christianity.	Gaining	sole
reign	of	the	empire,	he	is	also	noted	for	re-establishing	a	single	imperial	capital,	choosing	the	site	of	ancient	Byzantium	in	330	(over	the	current	capitals,	which	had	effectively	been	changed	by	Diocletian's	reforms	to	Milan	in	the	West,	and	Nicomedeia	in	the	East)	to	build	the	city	soon	called	Nova	Roma	(New	Rome);	it	was	later	renamed
Constantinople	in	his	honor.The	last	emperor	to	control	both	the	eastern	and	western	halves	of	the	empire	was	Theodosius	I.	As	the	century	progressed	after	his	death,	it	became	increasingly	apparent	that	the	empire	had	changed	in	many	ways	since	the	time	of	Augustus.	The	two-emperor	system	originally	established	by	Diocletian	in	the	previous
century	fell	into	regular	practice,	and	the	east	continued	to	grow	in	importance	as	a	centre	of	trade	and	imperial	power,	while	Rome	itself	diminished	greatly	in	importance	due	to	its	location	far	from	potential	trouble	spots,	like	Central	Europe	and	the	East.	Late	in	the	century	Christianity	became	the	official	state	religion,	and	the	empire's	old	pagan
culture	began	to	disappear.[citation	needed]	General	prosperity	was	felt	throughout	this	period,	but	recurring	invasions	by	Germanic	tribes	plagued	the	empire	from	376[1][2]	CE	onward.	These	early	invasions	marked	the	beginning	of	the	end	for	the	Western	Roman	Empire.In	China,	the	Jin	dynasty,	which	had	united	the	nation	prior	in	280,	began
rapidly	facing	trouble	by	the	start	of	the	century	due	to	political	infighting,	which	led	to	the	insurrections	of	the	northern	barbarian	tribes	(starting	the	Sixteen	Kingdoms	period),	which	quickly	overwhelmed	the	empire,	forcing	the	Jin	court	to	retreat	and	entrench	itself	in	the	south	past	the	Yangtze	river,	starting	what	is	known	as	the	Eastern	Jin
dynasty	around	317.	Towards	the	end	of	the	century,	Emperor	of	the	Former	Qin,	Fu	Jin,	united	the	north	under	his	banner,	and	planned	to	conquer	the	Jin	dynasty	in	the	south,	so	as	to	finally	reunite	the	land,	but	was	decisively	defeated	at	the	Battle	of	Fei	River	in	383,	causing	massive	unrest	and	civil	war	in	his	empire,	thereby	leading	to	the	fall	of
the	Former	Qin,	and	the	continued	existence	of	the	Eastern	Jin	dynasty.According	to	archaeologists,	sufficient	archaeological	evidence	correlates	of	state-level	societies	coalesced	in	the	4th	century	to	show	the	existence	in	Korea	of	the	Three	Kingdoms	(300/400668	CE)	of	Baekje,	Goguryeo,	and	Silla.Historians	of	the	Roman	Empire	refer	to	the	"Long
Fourth	Century"	to	the	period	spanning	the	fourth	century	proper	but	starting	earlier	with	the	accession	of	the	Emperor	Diocletian	in	284	and	ending	later	with	the	death	of	Honorius	in	423	or	of	Theodosius	II	in	450.[3]See	also:	Christianity	in	the	4th	centuryGregory	the	Illuminator	mosaic,	converted	Armenia	from	Zoroastrianism	to
ChristianityContemporary	bronze	head	of	Constantine	I	(r.	306337	AD)Early	4th	century	Former	audience	hall	now	known	as	the	Basilica,	Trier,	Germany,	is	built.Early	4th	century	The	Gupta	Empire	is	established.301:	Armenia	first	to	adopt	Christianity	as	state	religion.304439:	The	Sixteen	Kingdoms	in	China	begins.306337:	Constantine	the	Great,
ends	persecution	of	Christians	in	the	Roman	Empire	(see	also	Constantinian	shift)	and	Constantinople	becomes	new	seat	of	government	(New	Rome).Tikal	had	a	population	of	about	100,000	when	it	was	conquered	by	Teotihuacan,	less	than	a	fourth	of	its	peak	population[4]320:	Butuan	Boat	One,	the	oldest	known	Balangay,	a	multi-purpose	ship	native
to	the	Philippines	is	built.325328:	The	Kingdom	of	Aksum	adopts	Christianity.325:	Constantine	the	Great	calls	the	First	Council	of	Nicaea	to	pacify	Christianity	in	the	grip	of	the	Arian	controversy.335380:	Samudragupta	expands	the	Gupta	Empire.337:	Constantine	the	Great	is	baptized	a	Christian	on	his	death	bed.350:	About	this	time	the	Kingdom	of
Aksum	conquers	the	Kingdom	of	Kush.350400:	At	some	time	during	this	period,	the	Huns	began	to	attack	the	Sassanid	Empire.[2]350:	The	Kutai	Martadipura	kingdom	in	eastern	Borneo	produced	the	earliest	known	stone	inscriptions	in	Indonesia	known	as	the	Mulavarman	inscription	written	in	the	Sanskrit	language	using	Pallava	scripture.[5]Mid-4th
century	Dish,	from	Mildenhall,	England,	is	made.	It	is	now	kept	at	the	British	Museum,	London.Mid-4th	century	Wang	Xizhi	makes	a	portion	of	a	letter	from	the	Feng	Ju	album.	Six	Dynasties	period.	It	is	now	kept	at	National	Palace	Museum,	Taipei,	Taiwan,	Republic	of	China.365:	An	earthquake	with	a	magnitude	of	at	least	eight	strikes	the	Eastern
Mediterranean.	The	following	tsunami	causes	widespread	destruction	in	Crete,	Greece,	Libya,	Egypt,	Cyprus,	and	Sicily.376:	Visigoths	appear	on	the	Danube	and	are	allowed	entry	into	the	Roman	Empire	in	their	flight	from	the	Huns.378:	Battle	of	Adrianople:	Roman	army	is	defeated	by	the	Visigoth	cavalry.	Emperor	Valens	is	killed.378395:
Theodosius	I,	Roman	emperor,	bans	pagan	worship,	Christianity	is	made	the	official	religion	of	the	Empire.378:	Siyaj	K'ak'	conquers	Waka	on	(January	8),	Tikal	(January	16)	and	Uaxactun.Wall	painting	of	the	Council	of	Constantinople	(381)	in	the	Stavropoleos	monastery,	Romania381:	First	Council	of	Constantinople	reaffirms	the	Christian	doctrine	of
the	Trinity	by	adding	to	the	creed	of	Nicaea.383:	Battle	of	Fei	River	in	China.395:	The	Battle	of	Canhe	Slope	occurs.395:	Roman	emperor	Theodosius	I	dies,	causing	the	Roman	Empire	to	split	permanently.Late	4th	century:	Cubiculum	of	Leonis,	Catacomb	of	Commodilla,	near	Rome,	is	made.Late	4th	century:	Atrium	added	in	the	Old	St.	Peter's
Basilica,	Rome.For	a	more	comprehensive	list,	see	Timeline	of	historic	inventions	4th	century.The	Stirrup	was	invented	in	China,	no	later	than	322.[6][1]Kama	Sutra,	dated	between	c.400	BC	to	c.	300	AD.[7][8]Iron	pillar	of	Delhi,	India	is	the	world's	first	Iron	Pillar.[citation	needed]Trigonometric	functions:	The	trigonometric	functions	sine	and	versine
originated	in	Indian	astronomy.[9]Codex	Sinaiticus	and	the	Codex	Vaticanus	Graecus	1209,	are	the	earliest	Christian	bibles.[10][11]Book	of	Steps,	Syriac	religious	discourses.[citation	needed]^	a	b	"The	invention	and	influences	of	stirrup".	Archived	from	the	original	on	December	3,	2008.^	a	b	Roberts,	J:	"History	of	the	World".	Penguin,	1994.^	The
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edit)510s	(links	|	edit)View	(previous	50	|	next	50)	(20	|	50	|	100	|	250	|	500)Retrieved	from	"	WhatLinksHere/4th_century"Manage	multiple	sessions	from	a	single	window	with	a	tabbed	interfaceConnect	with	a	single	clickYou	no	longer	need	to	remember	IPaddresses,	login	details	and	credentials.Automate	your	SSHsessions	with	customized
snippets.Browse	your	server	files	and	folders	and	manage	them	easily.Upload	and	Download	FilesTransfer	files	and	folders	at	full	speed	with	an	easy	drag	&	drop.Embedded	code	editor	with	syntax	highlighting.	Edit	your	HTML/CSS/JS	files	without	leaving	Take	control	of	your	remote	servers	using	RDP	(Remote	Desktop/Terminal	Server)	or	VNC.Full
keyboard,	command	snippets,	sftp	browser	and	file	editor.	All	these	awesome	features	are	available	on	mobile.We	believe	that	connecting	and	managing	your	servers	and	network	devices	should	be	easy.That's	why	we	developed	these	great	features.Access	your	desktop	with	RDP	and	VNC.Shellngn	supports	32-bit	color	depth,	redirecting	sound,
clipboard	support,	and	more.Powerful	terminal	emulator	with	a	password	and	private	key	authentication,	full-colored,	auto-completion,	snippets,	and	more.Graphical	SFTP	browser	with	high-speed	upload	and	downloads,	advanced	file	editor	with	syntax	highlighting,	automated	zip	creation,	and	more.Save	and	organize	your	servers	into	folders.	Assign
icons,	add	notes,	and	configure	their	settings.	Connect	to	your	servers	with	a	single	click.Instead	of	updating	every	connection	when	you	change	your	password	-	just	update	the	identity	and	any	connections	linked	to	it	will	use	the	new	password/key.Forget	about	installing	new	updates.	We	keep	adding	new	features	every	week.	You	never	have	to
upgrade	or	install	anything.	You	will	have	it	in	your	browser.	Share	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution
You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the
original.	No	additional	restrictions	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.
The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Multi-Remote	Next	Generation	Connection	Manager	mRemoteNG	is	a	fork	of	mRemote:	an	open	source,	tabbed,	multi-protocol,	remote	connections	manager	for
Windows.	mRemoteNG	adds	bug	fixes	and	new	features	to	mRemote	and	allows	you	to	view	all	of	your	remote	connections	in	a	simple	yet	powerful	tabbed	interface.	mRemoteNG	is	open	source	software	and	is	released	under	the	terms	of	the	GNU	General	Public	License	Version	2.	Supported	protocols:	RDP	(Remote	Desktop	Protocol)	VNC	(Virtual
Network	Computing)	SSH	(Secure	Shell)	Telnet	(TELecommunication	NETwork)	HTTP/HTTPS	(Hypertext	Transfer	Protocol)	rlogin	(Remote	Login)	Raw	Socket	Connections	Powershell	remoting	Supported	languages:	English	Nederlands	Franais	Deutsch	Magyar	Italiano	Norsk	Polski	Portugus	Espaol	SecureCRT	combines	rock-solid	terminal	emulation
with	the	strong	encryption,	data	integrity,	and	authentication	options	of	the	Secure	Shell	protocol.	SecureCRT	provides	secure	remote	access,	file	transfer,	and	data	tunneling	for	everyone	in	your	organization.Want	a	really	good	SecureCRT	alternative?	Take	a	look	at	these	popular	alternatives	if	you're	hunting	for	software	similar	to	SecureCRT.	Let's
take	a	quick	peek	at	some	comparison	that	highlight	your	device	and	platform.FreeOpen	SourceFreemiumFree	PersonalFreeOpen	SourceWindowsLinuxBSDPortableApps.comReactOSPuTTY	is	a	free	and	open-source	terminal	emulator,	serial	console	and	network	file	transfer	application.	It	supports	several	network	protocols,	including	SCP,
SSH...Features:SSHBuilt-in	SSH	clientTelnet	clientHost	managementSupport	for	SFTPConfigurableDownload	AcceleratorsLightweightSession	managementTabbed	interfaceTerminal	emulatorXterm	emulationFreeOpen	SourceMacWindowsLinuxiPhoneBSDCygwinHaikuOpenSSH	is	a	free	version	of	the	SSH	connectivity	tools	that	technical	users	rely
on.	OpenSSH	encrypts	all	traffic	(including	passwords)	to	effectively	eliminate...Features:EncryptionFile	transferJailbreak	requiredBundled	with	macOSNetworkingSupport	for	SFTPSSHFreeOpen	SourceWindowsKiTTY	is	an	opensource	terminal	emulator,	forked	from	PuTTY	,	that	adds	many	extra	features	to	the	original	software.	The
very...Features:PortableSSHSsh	tunnelAuto-savingAuto-loginBuilt-in	editorSupport	for	Keyboard	ShortcutsMultiple	Browser	TabsSession	managementTerminal	emulatorFreeOpen	SourceWindowsmRemoteNG	is	a	fork	of	mRemote,	an	open	source,	tabbed,	multi-protocol,	remote	connections	manager.Features:RDP	FunctionalitySSHBuilt-in	SSH
clientSupport	for	Multiple	protocolsTabbed	interfaceRDP	sessions	in	a	tabRemote	desktopVNC	ViewerConnect	via	RDPLinux	ManagementRemote	desktopSecure	Copy	(SCP)Supports	SSL	certificateTabsTree	viewVnc	protocolFreeOpen	SourceAndroidConnectBot	is	a	Secure	Shell	client	for	the	Android	platform.	Its	ultimate	goal	is	to	create	a	secure
connection	through	which	you	can	use	a	shell	on	a	remote	machine...Features:FreeOpen	SourceLinuxPAC	is	a	Perl/GTK	Gnome	replacement	for	SecureCRT/Putty/etc...	It	provides	a	GUI	to	configure	SSH/Telnet	connections:	users,	passwords,	EXPECT	regular	expressions...Features:Tabbed	interfaceGroup	connectionsSupport	for	Multiple
protocolsPassword	managementRDP	sessions	in	a	tabRemote	desktopSSHTerminal	emulatorAdd	your	reviews	&	share	your	experience	when	using	SecureCRT	to	the	world.	Your	opinion	will	be	useful	to	others	who	are	looking	for	the	best	SecureCRT	alternatives.	OpenSSH	10.0	released	April	9,	2025	OpenSSH	is	the	premier	connectivity	tool	for
remote	login	with	the	SSH	protocol.It	encrypts	all	traffic	to	eliminate	eavesdropping,	connection	hijacking,and	other	attacks.In	addition,	OpenSSH	provides	a	large	suite	of	secure	tunneling	capabilities,several	authentication	methods,	and	sophisticated	configuration	options.	The	OpenSSH	suite	consists	of	the	following	tools:	OpenSSH	is	developed	by
a	few	developers	of	theOpenBSD	Project	and	made	availableunder	a	BSD-style	license.	OpenSSH	is	incorporated	into	many	commercial	products,	but	very	few	of	thosecompanies	assist	OpenSSH	with	funding.	Contributions	towards	OpenSSH	can	be	sent	to	theOpenBSD	Foundation.	Reddit	and	its	partners	use	cookies	and	similar	technologies	to
provide	you	with	a	better	experience.	By	accepting	all	cookies,	you	agree	to	our	use	of	cookies	to	deliver	and	maintain	our	services	and	site,	improve	the	quality	of	Reddit,	personalize	Reddit	content	and	advertising,	and	measure	the	effectiveness	of	advertising.	By	rejecting	non-essential	cookies,	Reddit	may	still	use	certain	cookies	to	ensure	the
proper	functionality	of	our	platform.	For	more	information,	please	see	our	Cookie	Notice	and	our	Privacy	Policy.	MobaXterm	is	your	ultimate	toolbox	for	remote	computing.	In	a	single	Windows	application,	it	provides	loads	of	functions	that	are	tailored	for	programmers,	webmasters,	IT	administrators	and	pretty	much	all	users	who	need	to	handle	their
remote	jobs	in	a	more	simple	fashion.	MobaXterm	provides	all	the	important	remote	network	tools	(SSH,	X11,	RDP,	VNC,	FTP,	MOSH,	...)	and	Unix	commands	(bash,	ls,	cat,	sed,	grep,	awk,	rsync,	...)	to	Windows	desktop,	in	a	single	portable	exe	file	which	works	out	of	the	box.	More	info	on	supported	network	protocols	There	are	many	advantages	of
having	an	All-In-One	network	application	for	your	remote	tasks,	e.g.	when	you	use	SSH	to	connect	to	a	remote	server,	a	graphical	SFTP	browser	will	automatically	pop	up	in	order	to	directly	edit	your	remote	files.	Your	remote	applications	will	also	display	seamlessly	on	your	Windows	desktop	using	the	embedded	X	server.	See	demo	You	can	download
and	use	MobaXterm	Home	Edition	for	free.	If	you	want	to	use	it	inside	your	company,	you	should	consider	subscribing	to	MobaXterm	Professional	Edition:	this	will	give	you	access	to	much	more	features	and	the	"Customizer"	software.	Features	comparison	When	developing	MobaXterm,	we	focused	on	a	simple	aim:	proposing	an	intuitive	user
interface	in	order	for	you	to	efficiently	access	remote	servers	through	different	networks	or	systems.	Screenshots	MobaXterm	is	being	actively	developed	and	frequently	updated	by	Mobatek.	Fully	configured	Xserver	based	on	X.org	DISPLAY	is	exported	from	remote	Unix	to	local	Windows	Your	remote	display	uses	SSH	for	secure	transport	Based	on
PuTTY	with	antialiased	fonts	and	macro	support	Basic	Cygwin	commands	(bash,	grep,	awk,	sed,	rsync,...)	You	can	extend	MobaXterm	capabilities	with	plugins	All	your	network	tools	in	one	app:	Rdp,	Vnc,	Ssh,	Mosh,	X11,	...	MobaXterm	has	been	packaged	as	a	single	executable	which	does	not	require	admin	rights	and	which	you	can	start	from	an	USB
stick	MobaXterm	Professional	has	been	designed	for	security	and	stability	ChangelogBug	fix:	The	return	values	of	a	launch	tool	might	not	get	properly	parsed	in	some	casesMinor	improvements	to	the	internal	launch	tools	x64	Portable	Edition:WinSSHTerm-2.40.1-x64.zip	SHA256	(.ZIP_X64):
0BE231EED9E0BCCB10A9664109B49BEB8FEA8CE54FC2924374F8DA852FE66F10	SHA256	(.MSI_X64):	C46CFE8C6EBB7D028FBE8D85A68B5C902016C63F415AE4F54B45B594346F79EBSHA256	(.ZIP_ARM64):	47B314BACDB0386B52E7FB1667A3A1A51879C027EEEDC693E510F56446025931	SHA256	(.MSI_ARM64):
F8E19667D8F669EB5EBE07BE5D47F138D1DD26DEEF2C3D8A726889737EDE2D5F	Page	2	X	should	work	out	of	the	box	if	you	did	not	skip	the	X-Server	installation	in	the	initial	setup.	Simply	open	a	connection	and	start	a	X	application	(e.g.	"xeyes"	like	you	can	see	on	one	of	the	screenshots).If	this	doesn'	work,	you	need	to	make	sure	that	a)	the	X-
Server	is	installed	and	b)	the	X-Server	is	running.	Both	can	be	controlled	in	the	Preferences	menu	(Preferences->X-Server).	To	install	the	X-Server,	click	on	"Download"	to	download	the	file	"VcXsrv-portable-1.17.2.0.zip"	and	after	that	select	this	file	by	clicking	on	"Install".	To	start	the	X-Server,	click	on	the	"Start	X-Server"	button.2.	How	to	use	the
"Copy	Files"	feature?	If	you	right-click	a	connection	you	can	open	up	a	WinSCP	session	by	clicking	on	"Copy	Files".	WinSSHTerm	sends	the	connection	configuration	to	WinSCP,	so	there	is	no	need	for	manually	creating	a	session	in	WinSCP	and	this	is	a	good	thing.	Usually	WinSCP	will	open	up	the	user's	home	directory.	You	can	change	this	by
highlighting	the	full	directory	path	in	PuTTY	before	clicking	on	"Copy	Files".	WinSCP	will	then	open	up	and	automatically	try	to	cd	into	that	directory.To	enable	this	feature,	you	need	to	make	sure	that	the	portable	executable	of	WinSCP	is	installed	(Preferences->Copy	Files).	If	you	need	to	change	some	WinSCP	settings	(e.g.	configuring	a	proxy),	you
can	do	this	with	command-line	parameters.	For	more	information	please	have	a	look	here	andhere.	Besides	the	shortcuts	from	PuTTY,	WinSSHTerm	provides	additional	shortcuts	which	are	listed	in	the	menu	(Navigate->Shortcuts).	WinSSHTerm	uses	one	shared	PuTTY	session	(called	"WinSSHTerm")	for	all	connections.	You	can	open	PuTTY	and
manually	change	the	session	settings,	which	aren't	configurable	in	WinSSHTerm	and	see	if	this	works	for	you.	However,	if	you	manually	change	the	session	settings,	then	WinSSHTerm	won't	be	fully	portable	any	longer.	All	custom	changes	will	be	lost	if	you	switch	your	computer	or	reset	the	PuTTY	session	file	"WinSSHTerm".	If	you	find	yourself	in
this	situation	please	contact	me.	If	you're	using	the	.msi	installer	edition,	then	simply	download	the	new	version	and	install	it.	To	update	the	portable	edition,	download	the	new	version,	extract	the	zip	and	replace	the	file	"WinSSHTerm.exe".	In	order	to	update	the	embedded	tools	like	PuTTY	or	WinSCP,	go	to	Preferences	menu,	download	the	new
version	and	overwrite	the	old	files	by	clicking	on	"Install".	This	bug	was	fixed	in	version	1.3.6.	It	is	possible	to	switch	the	tabs	with	CTRL+TAB	and	CTRL+SHIFT+TAB	-	this	is	the	standard	keyboard	shortcut	for	switching	tabs	in	MS	Windows.Edit:	This	still	seems	to	be	an	issue	in	very	rare	cases,	which	until	now	could	not	be	reproduced.	If	you	run
into	this	problem,	pressing	the	CTRL-key	once	should	revert	the	normal	behaviour.	WinSCP	checks	the	environment	variable	$LANG	on	the	remote	system	to	decide	whether	to	enable	UTF-8	or	not.	If	your	$LANG	is	set	to	"POSIX",	UTF-8	will	not	be	enabled.	To	force	UTF-8	in	WinSCP,	set	the	$LANG	to	e.g.	"en_US.UTF-8"	or	add	the	command-line
parameters	"/rawsettings	Utf=1"	in	Preferences->Copy	Files.	Without	the	master	password	it's	not	possible	to	decrypt	the	stored	passwords,	including	the	password	for	the	shared	connection	file	and	its	template	variables.	If	you	have	lost	your	master	password,	then	manually	delete	the	file	"key"	in	the	"config"	folder	and	start	WinSSHTerm.	It	will
start	without	the	password	prompt,	but	all	encrypted	data	will	be	deleted.	Edit:	Since	version	2.2.0	custom	terminal	colors	are	supported	and	set	up	under	File->Preferences->Terminal->Color	Scheme->Edit	Currently	WinSSHTerm	supports	only	the	color	schemes	"WinSSHTerm"	and	"PuTTY".	However,	it	is	possible	to	use	a	custom	color	scheme	by
following	these	steps	in	the	exact	order:	1.)	Start	WinSSHTerm	and	go	to	File->Preferences->Terminal2.)	Choose	Color	Scheme	->	ignore	and	click	on	Ok3.)	Import	the	custom	color	scheme	reg	file	into	the	PuTTY	session	"WinSSHTerm"	(you	can	also	manually	edit	the	colors	with	PuTTY)4.)	Open	up	a	new	connection	and	you	should	see	the	new	color
scheme	Please	note,	that	this	is	only	a	workaround	(more	info	in	section	4.).	Sorting	the	connections	tree	automatically	is	currently	not	supported.	However,	as	the	connections	are	stored	in	a	XML	file,	you	could	sort	the	connections	by	using	an	external	program	likeXML	Sorter	(mirror).	In	XML	Sorter,	just	open	your	"connections.xml"	as	source	(be
sure	to	make	a	backup	of	this	file	and	close	WinSSHTerm	before).	If	you	want	to	sort	all	connections	by	name,	then	select	Options->Sort	by	specific	attributes->Name	and	click	on	"Sort".	Now	wait	until	the	sort	process	finishes.	You	should	see	the	sorted	XML	in	the	"After"	textbox.	To	persist	the	changes	select	Target->Overwrite	source	file	and	click
on	"Save".11.	Connections	and	Config	windows	are	incorrectly	displayed	after	update	In	some	rare	cases,	after	updating	WinSSHTerm,	these	windows	might	be	incorrectly	displayed	and	you	can't	control	them.	Even	resetting	the	layout	(Views->Reset	Layout)	might	not	help.	In	this	case	close	WinSSHTerm	and	delete	the	file	"layout.xml"	in	the	config
folder.	After	starting	WinSSHTerm	the	default	layout	should	be	displayed.12.	PuTTY:	"Incoming	packet	was	garbled	on	decryption"	Since	2.22.0:	By	using	"SSH	Proxy"	as	Jump	Server	Mode	(File->Preferences->Terminal)	there	will	be	a	popup	window	if	the	host	key	of	the	jump	server	is	not	trusted.If	you	are	trying	to	connect	to	a	remote	server	not
directly,	but	by	doing	a	SSH	hop	over	a	jump	server,	this	error	might	occur.	It	occurs,	when	the	host	key	of	the	jump	server	has	changed,	and	the	new	host	key	is	not	trusted	yet	by	PuTTY.	To	fix	this,	open	up	a	connection	to	the	jump	server	-	you	should	see	a	security	alert	-	and	verify,	that	the	new	host	key	fingerprint	is	valid.	If	it's	valid,	click	on	Yes
to	permanently	trust	it.	It	should	now	be	possible	again	to	hop	over	the	jump	server.13.	What	do	you	do	with	donations?	Mainly	I	use	the	money	to	buy	(sadly	expensive)	code	signing	certificates	for	WinSSHTerm	and	to	pay	hosting	fees	for	the	download	server.	I'm	also	making	donations	to	other	projects	from	time	to	time,	like	e.g.	PuTTY,	as	you	can
see	on	the	screenshot	below.	14.	Error	loading	connections.xml	/	preferences.xml	In	rare	cases	these	files	might	get	corrupted	when	the	system	crashes	while	WinSSHTerm	is	persisting	to	the	file	system.	In	that	case,	exit	WinSSHTerm	and	go	to	the	config/	folder.	There	should	be	a	file	like	'connections__.xml'	/	'preferences__.xml'.	Rename	this	file	to
'connections.xml'	/	'preferences.xml'	and	start	WinSSHTerm	again.15.	PuTTY	changing	position	inside	window	A	user	(thanks	to	Adrian	P.)	reported	strange	behaviour	of	PuTTY/KTTY	-	changing	its	position	inside	the	window	when	the	mouse	cursor	passes	the	scrollbar.	It	turned	out	that	a	utility	by	Lenovo	caused	this	behaviour	-	the	"Lenovo	Auto
Scroll	Utility",	which	shows	up	as	"virtscrl.exe"	in	the	task	manager.	Disabling	this	tool	solved	the	issue.16.	Window	focus	issues	WinSSHTerm	uses	Windows	Hooks	in	order	to	get	notified	when	a	PuTTY	terminal	gets	activated.	These	hooks	can't	be	set	up	in	managed	code,	that's	why	there	is	the	need	for	the	unmanaged	library	'WinSSHTerm.dll'.	This
is	unfortunately	hacky	but	I	haven't	found	a	better	way	yet.By	using	hooks	it	is	e.g.	possible	to	bring	the	whole	WinSSHTerm	window	to	front	when	the	user	clicks	into	a	terminal,	or	to	detect	a	PuTTY	Fatal	Error.	Experience	has	shown	that	this	works	quite	well	-	however,	there	are	some	rare	cases	where	the	hooking	mechanism	suddenly	stops
working.	If	you	find	yourself	in	this	situation,	it	is	not	enough	to	restart	WinSSHTerm	-	you'll	have	to	log	your	Windows	user	off	and	on	again.17.	Tunneling	your	ssh	session	through	a	jump	serverSince	2.22.0:	By	using	the	new	feature	"SSH	Proxy"	as	Jump	Server	Mode	(File->Preferences->Terminal)	there	is	no	need	for	Plink	any	more.	Trusting	the
jump	server's	host	key	is	much	easier	than	the	old	way.Sometimes	you	are	not	allowed	to	directly	ssh	into	your	server	-	you	have	to	ssh	into	a	bastion	host	(or	jump	server)	at	first,	and	then	establish	the	ssh	connection	to	your	server	from	there.If	you	are	in	this	situation,	WinSSHTerm	can	automatically	set	up	a	tunnel	to	your	jump	server,	so	you	can
directly	ssh	into	your	server.	To	set	it	up,	please	do	the	following:1.)	The	tunnel	is	internally	set	up	with	Plink,	so	be	sure	to	install	Plink	under	File->Preferences->Plink2.)	Create	a	new	connection	to	your	jump	server	and	connect	to	it.	The	important	step	here	is	to	accept	the	host	key	from	the	jump	server	and	save	it	in	the	registry.	Important:	If	the
host	key	of	the	jump	server	is	not	stored	in	the	registry	(or	is	a	wrong	key),	the	tunnel	can	not	be	set	up	(see	also	FAQ	point	12).3.)	Now	create	a	new	connection	and	fill	in	the	connection	details	of	your	destination	server	under	Connection.3b.)	Additionally,	fill	in	the	connection	details	of	your	jump	server	(from	step	3)	under	Jump	Server	and	enable
the	feature	by	setting	SSH	Proxy	to	enabled.4.)	If	you	use	a	local	ssh	key	to	connect	to	the	final	destination	make	sure	to	enable	agent	forwarding	(Session->Agent	forward->Allow).	If	you	use	a	passphrase	protected	ssh	key	to	the	jump	server	either	use	Pageant	and	add	the	key	there	(Files->Preferences->Pageant)	or	provide	the	passphrase	to	the
key	in	the	password	field	of	the	jump	server	connection	setting.	It	is	recommended	to	use	Pageant	for	security	reasons.5.)	If	you	now	double-click	on	the	connection,	you	should	directly	log	into	your	destination	server.18.	Port	forwarding	In	case	you	want	to	use	port	forwarding,	you	can	do	this	with	PuTTY	command	line	arguments	"-L"	or	"-R".	If	you
e.g.	have	a	web	server	running	on	port	80	on	your	remote	server,	and	you	want	to	be	able	to	access	the	web	server	by	entering	"	"	in	your	local	browser,	then	you	can	enter	"-L	8080:localhost:80"	into	the	field	"Cmd-line	Args"	and	open	the	connection	to	forward	your	local	port	8080.19.	Debug	Logging	In	case	you	have	problems	with	establishing	a
connection	with	PuTTY	or	WinSCP	and	you	can't	find	the	reason	you	can	enable	debug	logs:	PuTTY1.)	In	the	configuration	for	the	connection	you	want	to	enable	debug	logs,	choose	a	new	file	for	logging	ouput	under	"Session->Log	file	name",	e.g.	C:\putty.log2.)	Set	"Session->Logging"	to	"SSH	packets"3.)	Now	open	the	connection	-	after	that	you
should	see	the	logs	in	the	file	"C:\putty.log"	WinSCP1.)	Make	sure	the	option	"Append	custom	command-line	parameters"	is	checked	under	File->Prefernces->Copy	Files2.)	Append	these	parameters	into	the	text	field	below/log="C:\winscp.log"	/loglevel=03.)	Now	open	the	connection	-	after	that	you	should	see	the	logs	in	the	file	"C:\winscp.log"20.
Switching	from	the	portable	to	the	installer	edition	If	you	are	already	using	the	portable	edition	of	WinSSHTerm	and	decide	to	use	the	installer	edition,	you	can	do	following:	1.)	Install	WinSSHTerm	by	double-clicking	the	.msi	package2.)	Make	sure	there	is	no	instance	of	WinSSHTerm	running	(also	no	WinSCP	and	VcXsrv)3.)	Copy	the	subfolders
"config"	and	"tools"	from	your	portable	edition	to	your	Documents	folder	"%userprofile%\Documents\WinSSHTerm\"4.)	Now	you	can	run	the	installer	edition	of	WinSSHTerm	In	the	configuration	of	your	connection,	set	the	color	as	a	rgb	value	(separated	with	a	comma)	in	the	field	Connection->Env	Color.	Example	for	red	background:	125,0,0It	is
recommended	to	use	different	template	variables	for	different	groups	of	connections.Changing	multiple	colors	is	optionally	possible	if	the	Environment	Color	Mode	'Change	terminal	colors'	is	selected	(File->Preferences->Terminal->Environment	Color	Mode).Syntax:	r_2,g_2,b_2[;n:r_n,g_n,b_n]*n:	Describes	the	PuTTY	color	id,	valid	values	are	0,	1	and
3	to	210	->	Default	Foreground1	->	Default	Bold	Foreground2	->	Default	Background3	->	Default	Bold	Background4	->	Cursor	Text5	->	Cursor	Colour6	->	Black7	->	Black	Bold8	->	Red9	->	Red	Bold10	->	Green11	->	Green	Bold12	->	Yellow13	->	Yellow	Bold14	->	Blue15	->	Blue	Bold16	->	Magenta17	->	Magenta	Bold18	->	Cyan19	->	Cyan	Bold20	-
>	White21	->	White	BoldA	basic	example	for	"Env	Color"	with	multiple	color	changes:234,30,30;0:244,230,200;1:244,230,200;5:244,230,200;8:244,230,200;9:244,230,200;10:244,230,200;11:244,230,200;12:244,230,200;13:244,230,200;14:244,230,200;15:244,230,200;16:244,230,200;17:244,230,200;18:244,230,200;19:244,230,200	Since	version
2.2.4	you	can	set	a	custom	PuTTY	session	(other	than	"WinSSHTerm")	for	a	connection	under	Session->Custom.	So	just	load	the	session	"WinSSHTerm"	in	PuTTY,	make	your	changes	(like	setting	the	protocol	to	telnet),	save	to	a	new	session	and	set	the	new	session	name	in	WinSSHTerm.	It	is	currently	marked	as	beta,	because	it	breaks
WinSSHTerm's	portability,	which	means	if	you	want	to	run	WinSSHTerm	on	another	computer	you	have	to	manually	move	your	custom	PuTTY	session(s).	For	security	reasons	(man-in-the-middle	attack)	PuTTY	or	Plink	requires	user	interaction	when	the	host	key	is	not	cached	in	the	registry	or	the	key	has	changed.	This	can	be	a	problem	when	you	e.g.
try	to	execute	commands	non-interactively	with	Script	Runner.	If	you	run	into	this	problem	you	can	automatically	trust	the	keys	by	clicking	on	"Trust	host	keys"	in	the	Script	Runner	window.	It	will	send	the	character	"y"	to	all	selected	servers	and	then	close	the	connection.	If	the	key	is	already	trusted,	you'll	see	the	login	prompt	in	the	output	field.
Please	note:	Be	sure	to	review	all	fingerprints	of	the	added	host	keys	afterwards	in	the	output	field,	as	there	is	a	risk	of	a	man-in-the-middle	attack	This	is	especially	important	when	you're	not	connecting	to	servers	in	your	local	network.	WinSSHTerm	supports	the	command	line	argument	/congroup,	which	stands	for	"connection	group".	It	will
automatically	open	the	connection	group	when	WinSSHTerm	starts.	The	syntax	is:WinSSHTerm.exe	/congroup="My	Group"EDIT:	Since	version	2.12.0	WinSSHTerm	will	automatically	detect	shims	and	handle	them	correctlyYou	can	set	the	custom	location	for	PuTTY	to	point	to	the	binary,	which	is	managed	by	Chocolatey.	However,	you	have	to	make
sure	to	set	the	custom	location	to	the	actual	binary,	and	not	to	the	"shim",	which	is	generated	by	Chocolatey.	If	you	install	the	Chocolatey	packages	"putty.portable",	the	"shims"	will	be	created	in	the	"bin/"	directory.	They	are	not	supported	by	WinSSHTerm.	So,	for	the	package	"putty.portable",	please	set	the	custom	location	in	WinSSHTerm
toC:\ProgramData\chocolatey\lib\putty.portable\tools\putty.exe	For	the	other	tools,	like	WinSCP,	VcXsrv,	Plink	and	so	on,	using	the	"shims"	is	supported	by	WinSSHTerm.	There	are	following	built-in	variables	available	for	each	connection{{CON.NAME}}	->	name	of	the	connection{{CON.HOST}}	->	hostname{{CON.USER}}	->	SSH	username
{{CON.PASSWD}}	->	SSH	password{{CON.PORT}}	->	SSH	port{{CON.DESC}}	->	description{{CON.CUSTOMID}}	->	a	custom	id	of	your	choiceThese	can	be	used	in	Scripts,	Script	Runner,	Multi-Input	Paste,	in	the	command-line	arguments	for	WinSCP	and	VcXsrv,	and	in	the	connection	configuration	itself	(local	and	shared).	Be	sure	to	enable
"File->Preferences->General->Enable	variables	globally".Additionally,	you	can	set	your	own	variables	under	File->Preferences->Connections->Template	Variables.	Variables	with	hidden	values	can	only	be	used	when	a	master	password	is	set.	1.)	Login	as	root	user	to	remote	server	and	make	sure	that	X11	forwarding	is	working	correctly2.)	Then	run
these	commands	as	root:	echo	$DISPLAY	>	/tmp/X_displayxauth	list	$DISPLAY	>	/tmp/X_cookie	3.)	Switch	to	another	user	with	sudo:	sudo	su	-	4.)	Now	run	these	commands:	export	DISPLAY=$(cat	/tmp/X_display)xauth	add	$(cat	/tmp/X_cookie)5.)	Now	X11	forwarding	should	work.	When	opening	a	new	SSH	session	this	procedure	has	to	be
repeated.28.	Connection	FilterThe	include	and	exclude	patterns	support	regular	expressions.The	connections	list	contains	the	folder	name(s)	of	a	connection,	the	connection	name,	and	additional	properties,	seperated	by	the	hash	sign.	These	properties	are:	Host/IP,	Port,	User,	Custom	Id.Example:	To	filter	all	connections	with	Host/IP	beginning	with
"192.168"	and	User	"root",	you	could	use	following	include	pattern:^.*$Use-case:	You	aren't	allowed	to	login	into	the	remote	host	as	root	user.	Instead	you	need	to	login	with	your	personal	user	account	and	then	switch	to	root	user	with	"sudo	su	-".	You	will	need	to	enter	your	password.In	WinSSHTerm,	you	can	set	up	a	connection	so	that	you	can
switch	to	root	by	just	entering	"s".Steps:Make	sure	that	you	have	set	a	Master	Password	(File->Master	Password)In	the	connection	configuration	enter	the	password	in	the	password	field	(make	sure	your	password	doesn't	contain	the	single	quote	character)In	the	field	"Login	Cmds"	enter	following:	echo	'{{CON.PASSWD}}'	|	sudo	-Si;	s(){	sudo	su	-;
};	export	-f	sIf	you	now	connect	to	the	host,	you	should	be	able	to	become	root	by	typing	"s"	and	hitting	the	enter	key	The	default	install	scope	is	"user".	That	means	when	double-clicking	the	msi	package,	WinSSHTerm	will	install	only	for	the	current	user,	without	the	need	for	admin	privileges.	To	install	WinSSHTerm	"system	wide",	you	can	pass	the
parameter	MSIINSTALLPERUSER="",	e.g..\WinSSHTerm-2.35.2-x64.msi	MSIINSTALLPERUSER=""Or,	if	you	like	to	install	with	"msiexec",	you	need	to	pass	the	parameter	"ALLUSERS=1":msiexec	/i	WinSSHTerm-2.35.2-x64.msi	ALLUSERS=1	31.	Execute	a	script	after	loginYou	can	configure	your	script	for	each	connection	in	the	field	"Login	Cmds".
Example:echo	"Hello";	echo	"World"There	are	some	cases,	where	this	won't	work.	In	that	case	you	can	wrap	your	script	inside	a	function	and	export	it.	You	would	then	need	to	call	the	function	manually	to	execute	the	script.	Example:f()	{	echo	"Hello";	echo	"World";	};	export	-f	fNow	you	can	run	the	script	by	typing	"f"	and	pressing	enter.You	can	also
use	variables	in	"Login	Cmds"	(see	point	26).If	you	want	to	set	the	custom	location	in	an	automated	manner,	you	could	set	any	of	these	system-wide	('machine')	environment	variables:#	path	to	putty.exe	WINSSHTERM_TERMINAL_CUSTOM_PUTTY_LOCATION#	path	to	pageant.exeWINSSHTERM_PAGEANT_CUSTOM_LOCATION#	path	to
puttygen.exeWINSSHTERM_PUTTYGEN_CUSTOM_LOCATION	#	path	to	plink.exeWINSSHTERM_JUMP_SERVER_CUSTOM_PLINK_LOCATION#	path	to	WinSCP.exeWINSSHTERM_COPY_FILES_CUSTOM_WINSCP_LOCATION#	path	to	vcxsrv.exeWINSSHTERM_X_SERVER_CUSTOM_VCXSRV_LOCATIONThese	environment	variables	will	be	read
when	WinSSHTerm	starts.	The	custom	location	will	be	set	if	not	already	configured.	In	case	you	want	to	make	sure	WinSSHTerm	always	uses	the	location	from	these	environment	variables,	you	can	append	"_X"	to	the	variable	names.There	is	a	screencast	that	shows	how	to	use	OpenSSH	certificates:	need	following	files:User	authentication:	your
private	key	in	PuTTY	format,	e.g.	my_user_private_key.ppk	(generated	by	you,	e.g.	with	Puttygen)your	OpenSSH	certificate	file,	e.g.	my_user_certificate.pub	(generated	with	your	public	key	by	the	one	who	manages	user	access)	Trusting	remote	hosts:the	public	key	file	of	the	OpenSSH	CA,	e.g.	ca_public_key.pub	(generated	by	the	one	who	manages
the	host	certificates)34.	Why	is	the	tab	not	closing	when	the	session	closes?By	default,	if	you	close	a	PuTTY	session	with	e.g.	CTRL-D	the	tab	title	will	be	marked	as	disconnected,	but	the	tab	won't	be	closed.	The	reason	for	this	behaviour	is	simple:	the	server	might	close	the	session	unexpectedly	-	if	then	the	tab	closes,	you	would	loose	all	of	the
terminal	history.However,	if	you	would	like	the	tab	to	close	when	the	session	is	closed,	you	can	set	"File->Preferences->Terminal->Close	Window"	to	"on	clean	exit".	This	way	the	tab	will	close	on	e.g.	CTRL-D.35.	How	to	use	Smart	Cards	or	FIDO	keys?PuTTY	doesn't	support	it,	however	there	is	an	open-source	project	"PuTTY	CAC"	available	on	GitHub
here.	As	it	uses	PuTTY's	code	base,	it	should	be	no	problem	to	use	the	PuTTY	CAC	binaries	in	WinSSHTerm.	There	is	a	GitHub	issue	about	this	topic.36.	How	to	use	the	Auto-Type	feature	(KeePass)	in	WinSSHTerm?Make	sure	the	option	"File->Preferences->General->Custom	PuTTY	window	title"	is	enabled,	so	that	the	PuTTY	window	will	contain	the
string	"user@host".	Now	you	can	set	the	string*{UserName}@{URL}*as	target	window	in	the	Auto-Type	tab	of	your	KeePass	entry	to	make	sure	KeePass	will	send	the	password	to	the	correct	terminal	window	with	the	global	hotkey	"CTRL+ALT+A".37.	How	to	set	up	a	ssh	tunnel	with	multiple	jumps?It	is	possible	with	the	internal	Launch	Tool
Multiple	Jump.38.	Where	can	I	see	the	docs	for	the	Launch	Tool	feature?The	documentation	is	available	in	the	GitHub	repository	Launch	Tools.	Compare	SecureCRT	alternatives	for	your	business	or	organization	using	the	curated	list	below.	SourceForge	ranks	the	best	alternatives	to	SecureCRT	in	2025.	Compare	features,	ratings,	user	reviews,
pricing,	and	more	from	SecureCRT	competitors	and	alternatives	in	order	to	make	an	informed	decision	for	your	business.	1	2	3	4	5	6	7	8	9	10	11	12	13	14	15	16	17	18	19	20	21	22	23	24	25	26	27	28	29	30	31	32	33	34	35	36	37	38	39	40	41	42	43	44	45	46	47	48	49	50	

Open	source	securecrt.	Alternative	to	securecrt.	Securecrt	free	alternative.


